
PLANET v3.3 Farmgate Nutrient Balance Help.doc                 
Page 1 of 16 

 

 

 

Planning Land Application of Nutrients for 

Efficiency and the EnvironmenT 

 
Farmgate Nutrient Balance  

Help file 
 

 

 

PLANET version 3.3 

 

 

 



PLANET v3.3 Farmgate Nutrient Balance Help.doc                 
Page 2 of 16 

Farmgate Nutrient Balance 

Overview 

This module calculates the quantity of nitrogen, phosphate and potash nutrients coming onto the farm 
through the farm gate (imported), balanced against those that are taken off the farm (exported) during a 
12 month period (assessment year). The difference between the quantity imported and exported is 
known as the ‘Farmgate Nutrient Balance’. If more nutrient is imported onto the farm than is exported off 
the farm, then the farm has a surplus of nutrient (a positive value shown in red); if more nutrient is 
exported than imported, then there is a deficit (a negative value shown in green). The calculated balance 
is compared against benchmark values to indicate if the farm is typical compared to other farms of the 
same type. 

The Farmgate Nutrient Balance module is not relevant to the NVZ rules but should be useful to identify if 
there are opportunities to improve nutrient management or planning on the farm. 

To use this module, you must first either create a new farm file or open an existing farm file. If you are 
starting a new file, then as a minimum you must enter the Farm name, STD code and postcode in the 
Farm Details tab before you can open the module – but you do not need to enter any other information. 
You will be prompted to save any changes before you enter the module. 

To use the module, select the Farmgate Nutrient Balance icon  from the task bar at the top of the 
screen, or select ‘Farmgate Nutrient Balance’ from the ‘View’ menu. 

The module will appear with four main tabs.  

• Farm and Cropping Details 
o Crop Type and Area including Fixed Nitrogen from legumes 

• Imports (5 tabs for types of Imports) 
o Livestock Imports 
o Animal Feeds Imports 
o Bedding Imports 
o Organic manures Imports 
o Inorganic Fertilisers Imports 

• Exports (5 tabs for types of Exports) 
o Livestock Exports 
o Livestock Products Exports 
o Harvested Crops Exports 
o Organic Manures Exports 
o Inorganic Fertilisers Exports 

• Nutrient Balance 

You will need to enter information into each relevant tab. The Nutrient Balance tab will then show you the 
Farmgate Nutrient Balance. 
  
To delete information from a row, highlight the row by clicking on the small grey cell at the far left hand 
end of the row and press the Delete key. Information can be deleted from some, but not all individual 
cells by pressing the Delete key. You can change, but not delete information from cells with drop-down 
menus. 
 
To clear all the information on a tab (screen), right click and select the Clear tab button. To clear 
information on all the tabs (screens), right click and select the Clear all tabs button. 

Further information to help with data entry is provided throughout PLANET by clicking on the  
buttons.  
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Important.  You can only save one set of data in this module.  For instance, if you enter data for a 
calendar year then this will be saved on your computer. However, if you then edit this data (e.g. for a 
later calendar year) the original data will be overwritten and only the new data will be saved. Therefore, if 
you wish to keep a permanent record of the PLANET calculation and report for a particular assessment 
year, you should either print out a hard copy of the PLANET report before making any edits to the data, 
or use the ‘Save As’ function in the File menu to save each set of data as a separate Farm file file which 
you will need to name individually.  

 

Important 

The information supplied in the PLANET software is for guidance purposes only and is not intended to 
fully substitute for professional agricultural advice. The specific statutory elements concerning water and 
nitrates are set out in the relevant national legislation land and you should refer to this legislation to find 
out exactly what you must do. The nutrient recommendations provided by PLANET are in line with 
national industry standard guidance. If in doubt, farmers should seek help from a qualified adviser.  

The user is responsible for ensuring the accuracy and completeness of all data entered and used by 
PLANET, and for any commercial decisions taken based on any of the PLANET recommendations or 
other outputs of this software. Use of the PLANET software is subject to the terms and conditions of the 
PLANET User Licence. 

PLANET v3 has been developed by ADAS and SRUC with funding and support from Defra and the 
Scottish Government. The software is maintained by ADAS. For further information, visit 
www.planet4farmers.co.uk or ring the PLANET Helpline on 08453 451302 (PLANET England and 
Wales) or 08456 023864 (PLANET Scotland). 
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Farm and Cropping Details Tab 

Use this tab to enter details of the farm and assessment year.  

 

1. The Farmgate Nutrient Balance is calculated for a 12 month period. Select the Start Date (month 
and year) from the drop-down lists.  

2. Select the Farm type which most closely describes your farm from the drop-down list. If your 
farm is a pig or poultry enterprise with little or no land choose ‘Arable with manures’. 

3. Next select the crop type from the Crop type drop-down list. Select ‘Other crops (including 
setaside)’ for most arable/horticultural crops. 

 
4. Enter the Area of each crop type for the required assessment year. Be careful to enter 

information in the required units.   
 

5. When you have completed entry of data, click on the Imports tab. 
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Imports Tab  

Click this tab and a series of tabs will appear for you to enter details of Livestock Imports, Animal Feeds 
Imports, Bedding Imports, Organic Manure Imports and Inorganic Fertiliser Imports that you have or 
intend to bring onto the farm (import) during the assessment year. 

 

Livestock Imports Tab 

Use this tab to enter details of the animals that are imported onto the farm during the assessment year. 
Do NOT enter details of those livestock that are already on the farm.  

 

1. Select the Livestock group – cattle, pigs, poultry or sheep/other. 

2. Select the Livestock unit (e.g. dairy heifer replacement, laying hens). 

3. The typical Weight of the livestock unit will be shown automatically, but you can edit this if you 
have more specific information.  

4. Enter the No. of units. Note that some categories are quoted in 1000’s, so if you have imported 
2000 laying hens enter 2 units not 2000. 
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Animal Feeds Imports Tab 

Use this tab to enter details of Animal Feeds that are imported onto the farm during the assessment 
year.  

 

 

1. Select the Animal feeds group and Animal feeds type using the drop-down lists. Do not enter 
home produced feeds. The options for the animal feeds group are concentrates, compounds, and 
forages. 

2. If the animal feed type you require is not shown press the Set New Defaults button to set up the 
name and nutrient content of a new feed type using the appropriate columns. Make sure you 
enter the nutrient content data in the correct units (see the  buttons). Press the Save Changes 
button to save the details of the new feed type which will then be available for selection on the full 
list of animal feed types. You can also use this procedure to make permanent changes to the 
default nutrient contents of any feed type. 

3. The default content of DM (dry matter), Crude protein, Phosphorus and Potassium of the 
animal feed type will be shown automatically. These can be edited if required, but make sure you 
enter the information in the correct units (see the  buttons). 

4. Enter the total amount of Purchases during the assessment year. Then enter the total amount of 
Stock at year-start (this is the amount in stock, if any, at the start of the accounting year) and 
Stock at year-end (this is the amount remaining at the end of the accounting year). The amount 
that is Used during the assessment year is then calculated automatically. However, you can 
enter this figure directly without entering values for ‘stock’. 
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Bedding Imports Tab 

Use this tab to enter details of Bedding that is imported onto the farm during the assessment year. Do 
not include details of home produced bedding. 

 

1. Select the Bedding type using the drop-down list. Do not enter home produced bedding. Each 
bedding type has a standard nutrient content which you cannot edit. 

2. Enter the total amount of Purchases during the assessment year. Then enter the total amount of 
Stock at year-start (this is the amount in stock, if any, at the start of the accounting year) and 
Stock at year-end (this is the amount remaining at the end of the accounting year). The amount 
that is Used during the assessment year is then calculated automatically. However, you can 
enter this figure directly without entering values for ‘stock’. 
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Organic Manure Imports Tab 

Use this tab to enter details of Organic Manures that are imported onto the farm during the assessment 
year. Do not include details of home produced organic manures. 

 

1. Select the Manure type using the drop-down list. Do not enter home produced organic manures.  

2. If the manure type you require is not shown press the Set New Defaults button to set up the 
name and nutrient content of a new manure type using the appropriate columns. Make sure you 
enter the nutrient content data in the correct units (see the  buttons). Press the Save Changes 
button to save the details of the new manure type which will then be available for selection on the 
full list of manure types. You can also use this procedure to make permanent changes to the 
default nutrient contents of any manure type. 

3. The default content of N, P2O5 and K2O of the manure type will be shown automatically. These 
can be edited if required but make sure you enter the information in the correct units (see the  
buttons). 

4. Enter the total amount of Quantity imported during the assessment year. Then enter the total 
amount of Stock at year-start (this is the amount in stock, if any, at the start of the accounting 
year) and Stock at year-end (this is the amount remaining at the end of the accounting year). 
The amount that is Applied to land during the assessment year is then calculated automatically. 
However, you can enter this figure directly without entering values for ‘stock’. 

 

If you have previously entered data into the Organic Manure Imports and Exports module, you can load 
this data by clicking the Load data button. If you then select ‘Yes’ to loading the data, data for all Organic 
manure imports for the 12 month period will automatically be imported to this tab.  

Note: If you select to import data using the Load data button, this will overwrite any data that already has 
been entered into this grid. 
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Inorganic Fertiliser Imports Tab 

Use this tab to enter details of Inorganic Fertilisers that are imported onto the farm during the 
assessment year.  

 

1. Select the Name of the fertiliser using the drop-down list.   

2. If the fertiliser name you require is not shown press the Set New Defaults button to set up the 
name and nutrient content of a new fertiliser using the appropriate columns. Make sure you enter 
the nutrient content data in the correct units (see the  buttons). Press the Save Changes button 
to save the details of the new fertiliser which will then be available for selection on the full list of 
named fertilisers. You can also use this procedure to make permanent changes to the default 
nutrient contents of any named fertiliser. 

 

3. For solid fertilisers make sure that the box in the column headed Solid or liquid is ticked. 

4. The default content of N, P2O5 and K2O of the fertiliser will be shown automatically. These can be 
edited if required but make sure you enter the information in the correct units (see the  buttons). 

5. Enter the total amount of Purchases during the assessment year. Then enter the total amount of 
Stock at year-start (this is the amount in stock, if any, at the start of the accounting year) and 
Stock at year-end (this is the amount remaining at the end of the accounting year). The amount 
that is Applied to land during the assessment year is then calculated automatically. However, 
you can enter this figure directly without entering values for ‘stock’. 
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Exports Tab 

Click this tab and a series of tabs will appear for you to enter details of Livestock Exports, Livestock 
Products Exports, Harvested Crops Exports, Organic Manure Exports and Inorganic Fertiliser Exports 
that you have or intend to move off the farm (export) during the assessment year. 

 

Livestock Exports Tab 

Use this tab to enter details of the animals that are exported off the farm during the assessment year. 
Include details of fallen stock. 

 

1. Select the Livestock group using the drop-down list – cattle, pigs, poultry or sheep/other. 

2. Select the Livestock unit using the drop-down list (e.g. dairy heifer replacement, laying hens). 

3. The typical Weight of the livestock unit will be shown automatically, but you can edit this if you 
have more specific information.  

4. Enter the No. of units. Note that some categories are quoted in 1000’s, so if you have imported 
2000 laying hens enter 2 units not 2000. 
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Livestock Products Exports Tab 

Use this tab to enter details of the Livestock Products that are exported off the farm during the 
assessment year. 

 

1. Select the Product type using the drop-down list. 

2. The Crude protein content will be shown automatically but can be edited if more specific 
information is available. Standard values for the P and K content of each product type are not 
shown, but will be used in the balance calculation - these cannot be edited.  

3. Enter the No of units sold. Note that some product types are quoted in Units of 1000’s, so if you 
have exported 10,000 litres of milk enter 10 units not 10,000. 
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Harvested Crop Exports Tab 

Use this tab to enter details of the Harvested Crop Products that are exported off the farm during the 
assessment year. 

 

1. Select the Crop group and Crop type using the drop-down lists.   

2. The default content of N or protein and the Units that this value is expressed in is then shown 
for some crop types (e.g. winter wheat). Where shown, this value may be edited if more specific 
information is available. Standard values for the P and K content of each crop type are not 
shown, but will be used in the balance calculation - these cannot be edited. 

3. Enter the total amount of Quantity harvested during the assessment year and the total amount 
of Crop used on farm. Then enter the Stock at year-start (this is the amount in stock, if any, at 
the start of the accounting year) and Stock at year-end (this is the amount remaining at the end 
of the accounting year). The amount that is Exported during the assessment year is then 
calculated automatically. However, you can enter this figure directly without entering values for 
‘stock’. 
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Organic Manure Exports Tab 

Use this tab to enter details of Organic Manures that are exported off the farm during the assessment 
year.  

 

1. Select the Manure type using the drop-down list.   

2. If the manure type you require is not shown press the Set New Defaults button to set up the 
name and nutrient content of a new manure type using the appropriate columns. Make sure you 
enter the nutrient content data in the correct units (see the  buttons). Press the Save Changes 
button to save the details of the new manure type which will then be available for selection on the 
full list of Manure types. You can also use this procedure to make permanent changes to the 
default nutrient contents of any manure type. 

3. The default content of N, P2O5 and K2O of the manure type will be shown automatically. These 
can be edited if required but make sure you enter the information in the correct units (see the  
buttons). 

4. Enter the total amount of Quantity exported during the assessment year.  

 

If you have previously entered data into the Organic Manure Imports and Exports module, you can load 
this data by clicking the Load data button. If you then select ‘Yes’ to loading the data, data for all Organic 
manure exports for the 12 month period will automatically be imported to this tab.  

Note: If you select to import data using the Load data button, this will overwrite any data that already has 
been entered into this grid.  
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Inorganic Fertiliser Exports Tab 

Use this tab to enter details of manufactured fertilisers that are exported off the farm during the 
assessment year.  

 

1. Select the Name of the fertiliser using the drop-down list.   

2. If the fertiliser name you require is not shown press the Set New Defaults button to set up the 
name and nutrient content of a new fertiliser using the appropriate columns. Make sure you enter 
the nutrient content data in the correct units (see the  buttons). Press the Save Changes button 
to save the details of the new fertiliser which will then be available for selection on the full list of 
named fertilisers. You can also use this procedure to make permanent changes to the default 
nutrient contents of any named fertiliser. 

3. For solid fertilisers make sure that the box in the column headed Solid or liquid is ticked. 

4. The default content of N, P2O5 and K2O of the fertiliser will be shown automatically. These can be 
edited if required but make sure you enter the information in the correct units (see the  buttons). 

5. Enter the total Quantity exported during the assessment year.  
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Nutrient Balance Tab 

This tab shows a summary of the information that you have entered and the calculated nutrient content 
values of the different imports and exports. When you select this tab you will be asked to save your 
changes. Click Yes to save the information you have entered on the preceding tabs. 

 

 

This tab shows the calculated nitrogen (N), phosphate (P2O5) and potash (K2O) contents of each import 
or export, and the net nutrient balance for the farm for the assessment year. The values are shown as kg 
of nutrient for the farm. 

If more nutrient is imported onto the farm than is exported off the farm, then the farm has a surplus of 
nutrient (a positive value shown in red); if more nutrient is exported than imported, then there is a deficit 
of nutrient (a negative value shown in green).  

Right click and press the Collapse all button to view only the totals for each category (top example) or 
the Expand all button to see the full details (bottom example). 
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Farmgate Nutrient Balance Report 

 

Select the Reports icon  to generate a printed report of your Farmgate Nutrient Balance. The report 
shown below is only the first page. The full report will be several pages long. 

 

 

 

The report will include benchmark Farmgate Nutrient Balance values. These are typical values for your 
farm type against which you can compare the calculated balances for your farm.  

If you have a nutrient balance surplus (a positive value shown in red) that is higher than the benchmark 
value, then you may be importing more nutrients than required and there may be opportunities to reduce 
your imports of nutrients (e.g. use less manufactured fertiliser).  

The report provides advice on ways of reducing or increasing the nutrient balance of the farm. 

To return to other modules in PLANET select the required icon from the task bar or use the ‘View’ menu. 


